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Compaq Visual Fortran 6. 6 8% & 55

E FHLEAT —4 FORTRAN 95 #£ /5, % & FORTRAN 95 % R b9 X #. H .2
B4 EAKS K FORTRAN 95 4% R A ZR G T £ &I KHHE M Visual Fortran % 7| 4 ¥
%% . Visual Fortran # 7| % # % 4 & & T Microsoft 2 & T 1995 4 JF X # Fortran
PowerStation 4.0(FPS 4. 0) % # £ %. M A &£ 4 & T 4 B Microsoft 2 7 & # 7T & i
Developer Studio & & FF Z ¥ 3%, % FORTRAN 2 F 8y F A # A B £ 7w R ey # k. 1997
# 3 A, Microsoft A & f1 DEC /A & A 1, # # 7 Digital Visual Fortran 5. 0 (DVF 5. 0)
1998 4= 1 H ,DEC /A # # Compaq /A # % 1, Digital Visual Fortran ¥ 4 # Compaq Visual
Fortran(CVF), —A# 4 # )R X & Compaq Visual Fortran 6.5, A & K £ 6. 6(CVF 6.6),
A ZE H E N4 Compaq Visual Fortran 6.6 £ R AKX FFEHER F %,

1.1 RENESSRIEFRE

1.1.1 REGZES5R

Compaq Visual Fortran 6. 6 LK HF ik 5 HMBF N LE T ELEMU TEETAH
Compaq Visual Fortran 6. 6 Z& 45 U4 096483 A G & 3K sh 8% . 332 17 L 2& 72 1F (Setup. exe)
Rg RGP AP #EITEEARE ATERALE LK.

iZf7—4> FORTRAN 95 7, H %R sh T RHEE. # M#E shr ik RH e £ 7F
7" A B F"—“Compaq Visual Fortran 6”—“Developer Studio” ¢ x4,

1.1.2 ZGHEERT

Ji 8l Compaq Visual Fortran 6.6 f5 . 8i#t A T HEHO . ZAEMA P R mEmE 1-1 s,
Compaq Visual Fortran 6. 6 A FE% 1l 5 #4020 B AR RS (S8R | T HAS RAESREA T
fEd O,
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Ready [ tn1,cott  [REccot jovitiReap ]

[# 1-1 Compaq Visual Fortran 6. 6 19 ¥ % 1

1. #7442

FRai R0 T R G FE 8 1 AR, 43 0 s S AT JF A9 TAE %5 6] % 8 H AR Compaq Visual
Fortran” {7 7 09 30 4 5545 B

2. KA

FHRLA “File” " Edit”, “View”, “Insert”, “Project”, “Build” . “Tools” . * Window " Hl
“Help”9 AR, SEPNEATRES HBMEREANF A A, Hd, “File" R BH T 5%
T AEZS 8] 0 H SRR T R AF 5 TAE " Edid” S8 50/ T 58 il g 38 18 ok 28l L
SRS EEERAE ;¢ View”SE 8] Ti% & Compaq Visual Fortran 6. 6 £ M A9 R 773X ; “Insert” 2§
P T AR H o B 0 58 A2 ) BT IR 5 Project” 3 8L T 58 MU B WO L WS 0 L iR B SE R
“Build” 2 5 F 58 5O R 7 00 4 128 A R LG E SE R AR Tools "SR M ] AL T30 H
YIaE;“ Window” B ] FEBE O .02 O J5: “Help” X H FRALH EE &G
B TB.

SR A SRRV S R M A THE SRR AT BB AL T 1 U LR A M S
), S B2 20 ) g T30 f R 4 TR AE (P AR A I 2R ) o 4 5% A TOU R0 8 Fe 8 ) 4 il S 7S 4
T SR ZE A 0, D) O s 4 . HE S T, D R B L AR B R D
DU SR B AR Y — VR B B . WA XGRS R R S O, X SRR R S
1T ol 3 B A A S SR A

3. LA

THRERME T — w0 RE, REHEM O M BiE LT BR80T BERHEA H B
2R

(D T RALY 718 5 B

F 8 0 ERIA B8 “ Standard” , “Build MiniBar” F1“Fortran” T B4, H 4t T B £ 8 i
52 Bl 6 B HE R B . AR TS S P X SO O DXl A SR TR SR A, B
P Tools”*Customize” 3 B4y 2, M H “ Customize” CGE ) X i HE . £ £ “ Toolbars” & 77
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ol 1-2 s, AUR TAPARZMA TS 7 W B 7R % THEAS, 7 0 oK T A, 3
il T HAS 44 PR AT 7E 2 7 Bl BRIk 25 =2 1] U 4k

Customize

Commands Toolbars I Tools 1 Keyboard l Add-ins and Macro Files ‘

Toolbars: New... 1
TR~ show ToolTips
iviStandard ¥ With shortcut keys

(Build

¥iBuild MiniBar I Large buttons Reset i
[ IResource

LIEdit Reset All ]
CiDebug i

[IBrowse
iviFortran
Toolkar name:
ent bar
& 1-2 “Customize” % i HE
() TRMHIFSE S F3)

TEPEAEGERMFENREE. TEEREERIE SRS TR,

() THF A 5 HiE

FH P AT AR % 7 A0 R A T B, ol o R A 3R B B 4T JF “ Customize” X 35 HE L i $F
“Toolbars” I , 8ot “New” #& 4l , # H “New Toolbar” %f i #E , fiy A B T. B A% 24 K, 5
“OK %41 , BRI A] B g — A #7025 1 THAZ , IF7E“ Toolbars” # 1 K 76 il 1) “ Toolbar” 51| R AE H
A —ANH TEAL, B AT SRR R SCR & O R %% 1 THRE, 7E“Commands”
IR, 7 Category” T RS FRHE h BE 8 — Ay 2 ZS 8 (N File 288D , A 051 H i 2R B A W)
fir A BEAR B — A A AR G HE E —Tle X T RSO P A T AR A3E Y6 &, Bl Al 78
TR T A . W33l )5 /9 T B4 B AR 1) 4 4 3h— L, AT T R (O
D38 — e 2%, S 2R . AT EFE Menus 2880 B il XCR BT 2 T HAH . 8 New
Menu 28 , AT 6] 57 (9 32 0, 7 B 2S00 T 6 BT 0 T RAE

B4Customize” MIFGHEIT A F. I EEF O P E TEMEAOE T HEMHHRF#EE
“Customize” X IHHE , B AT 78 1% T H AL Hh BOH % T HAH .

4. R EA

Compaq Visual Fortran 6. 6 £ & HJRMAPREZBR 75 R LA REHEHE L
RER AN BR T BARBTHE 8] 1Y 3¢ 5 A 4 5 T B 3 8 B ST A 4845 , Ln #1 Col J5 BB 8w
VRSP A OGAR BT AE R AT RS . REC,COL, OVR Fl READ 43 Il %R A % 8% & B b T
SR 2R FNHAR S B R AL DL R 3 0y ST IR S

TEARSFE FE B R RGP Tools”—“Options” S Ly 4, Y £ “ Workspace” 1% i
+, % “Display clock on status bar” (FEAR &AL B R B8 Z % HE ., ZRBURSE, H R
“Display status bar” Cg 7R RERS) B HEAE P 13t P irid .

5. LHH o

Compaq Visual Fortran 6. 6 T AR A S LR T/EE D, XEH OHF TIESEH
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. ESCHED S E O MEFERE D, TAEZREE O8R5 H & IR SO & f
PE5E IR SCHEE O B RS AN A 3 0 7R 4 i e S A A R A RS (S B
w0 BRAXEFEANGER.

X UEHE 0] LA4r A P2 3CHY (Document) & F1 A AT 48 5 (Dockable) % 11, & {1 H fiE Ja BR
7t Compaq Visual Fortran 6. 6 B9 F & 0N . CRE O A LLJE 8 K/ e KAk s /b ; mT 45
RE O RTFEEFEINFEEOMNSEMNE.

(DICHE A

SCRY S A 46 SCA R o O B U B 6 1, SORS % H & A0 IR R AE— =AY L O I H I
AR T EMNNME KNEFEE. ATUESCHE O S 4, o s i, P b

T H5HEOYEPREME R 2.

A] LA$ZE Windows #4E R 40 b &7 1 #R4E 0 5 B R B & > SCRY 6 1A R/ VR 8, o mT LA
Compaq Visual Fortran 6. 6 ¥ & 1 A “ Window ” 3£ B 1 % # “ Cascade” (JZ2 &) . “ Tile
Horizontally” GKEHES) Fi1“ Tile Vertically” (3 B HES) 3 86y 2 S HES 4 11, 8% £~ Split”
(FEDRRGARSEEO,

BAEAT I B B AT E AL & B S0 L AT LLEEFE Tools” " Options” 3% Hifir 2 78 i ti Y
“Options” ¥ TEHE 1 & “ Workspace” BT R , W& 1-3 frx . #E H H A Reload documents
when opening workspace” (T FF 35 H B8 A 30 H A2 & 19 SCRY) &L 4E , fF i OK " #& 4l .

Tabs | Debug | Compatibility | Build | Directories Workspace | & (]3]
Docking views:
[“Output__ ¥ Display status bar
[¥Watch I~ Display clock on status bar
[“IVariables © Reload d i . .
MRegisters v Beloa BRoREmng P
MMemory ™ Reload last workspace at startup
[¥ICall Stack
FiDisassembly ¥ Automaticaily sort window menu
@Fortran Arrays ™ Use screen reader compatible menus
[¥Workspace ¥ Show recently used items on submenus
Window menu contains: 10 windows
Recent file list contains: |4 files
Recent workspace list contains: |4 workspaces

OK l Cancel l

F 1-3  “Options” %} 3 4E £ “ Workspace” $E I

(2)AMEREE 1

AJ{EEE S O 0] LIEEEAE Compaq Visual Fortran 6.6 =% O AU JE ] LSk 77 3h
H. AIE5EE O $ Workspace CTAEZS [0 # 1. Output Ciiy tH) 8§ H . Watch (£ F) % [,
Variables(ZZ &) % 0 .Registers(FfF4%) & 1 . Memory (N {7) % 1, Call Stack (HE# I ) &
M \Disassembly (R 4i) & M, Hrp A 8 TR O BAERRKER T A e B, 506 0%
L EFEREE NS shE O A RER R PR E T 56 0 Y /R ESH 42

AEREE O WA g B AR T RS O, IR DB R, LE’JE%L%.—I@Q‘?
B O RELUMEEE S O R 367 0 sSCR 3 DB B, R AR T O O A T SRRy L AT L
HEFE“ Tools”—*“Options” 3 Hdxr 4, 76 H B A “ Options” X FH HE o 2k - Workspace” S 1 . 7F
“Docking views” 5| RHEP LT E R E R E O, FRE“OK”HH.
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AT DA FE AT fa] A S5 7S B PR Hh B DR TAE S T O, 1 A 8 0 R REE W IR T A
e BER—AAEEE O, A View” R M T B8R E 02K, Sk d &8 Alcto,
Alt+2, 0 Alt+8, ZRRGE—A 0] {F5EE O, 7] LU7E T 75 Bl () rT (5 58 o O v o o PR FE i
AP BE S B b R B Hide" S B fr 2 . WURFTESEE O LIFEsh & H B X 7R, sig ik & h 3k
FERER (LRI & OB B0, iz 8 O A7 B AR A e sk 6 T 0

AR ST O R AL E S I E AR DGR, (E A g e A R S BT AL BT AR TR . AT
(A DA B FOR S AFFRETNIFE R E . B RENE O RS & O, /] % 3 BUnfs
8 0 b A XSO XU 50 B BUbR A a1 8 DA B B KO sh & 0BG S L
BRI FEEOMMNE ., BTt OB EEmeE 0, a3 B m & O Ll iR
BRI Ak, BB ol PR TS R 8 D 3 B AR RS R i Bh 8 D SR EE D R,

B BT B BT A9 K/, T LUK A Windows BRPE R GO 8 84 i B EREH O
A/ S BT LA R BR b 48 3l i R B 4 B SRR S B .

1.2 ERETNLR

REF BT W AP R BN R TR P XM 5 4 R IR A e S 1 26 i E A 8 e X 5 i
2 HARFR Y SO A BRI BRAT 72 7 SO s .8 AT AT AT #2330 (BEERR T R B b 2 8 = Al
7 A R Y SO A A R R SO L U S A At S AR ¥ Al B SO (I R SR A ik &R
Gt B A R B 5 ) 5 33 B S A B OGHK , B B 2 2L e SO R R R — T E T
VB FEBLFERAT I — LR W TF R IR EE P , — R F TAE %S Al (Work Space) #1335 H (Project) %
R S, — AN P T AR R AT T R B R 2 B 43 ) B B & A AR A ) BT SO
Je) A TAE 2 () ] B @ 24500 H GEALTFF 3092 , 54350 B 9 3R] 61 22 A: iR OC fY R
TR SO 9 U8 SC 4 Fn HoAth 26 78 1Y 4 Bh SC 4. R E , 7 Compaq Visual Fortran 6. 6 3358 T iz
47—~ FORTRAN 95 BFif , § e B TAE= MDA .

1.2.1 fIEIT{E=ZIE

B #E— > T 4E %5 8] BB 8 — > 37 S0 I, 3 78 b A2 BB AN 8 38 S0 (C dsw SO FL opt
)., BAREEAEA TR . #E Compaq Visual Fortran 6. 6 f 3% 0 %£#F“File”>“New” 3 #.4y
A>3 “New” X EHE B Workspaces” T, 7£“Workspace name” L AHE fil“ Location”
SCASHE R 43 Bl 4 A T AEZS 8] 2 F0 B 42, X B A B9 T4E %5 ] 4 0 “jasmine”, BB A “E:\
jasmine”, {0 1-4 fi7n A SE I B “OK ML B TAEZ ], BRARM AR AT @ o M & 0
AR AE AL .

Blg T ez [l J5, W7 T4E = | & O b & 57 3 89 3%E 51K “FileView”, [ i & 78
“Workspace 'jasmine’ :0 project(s)”, 3§ th T.¥E%s [a] & FR A3 H B, & 1-5 frn. #E E &
A ESH S E\jasmine, I 4 B A4~ T/E 25 6] & B SC {4 : jasmine. dsw # jasmine. opt.,
Al LAfE Windows $E IR H A% F & & TAE %S 0] SO Je FIAH OC Y S . an SR B AT IF TAE % 1)
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Files | Projects |Worksp Other D |
Blank Workspace Workspace name:
Ijasmine
Location:
’E:\iasmlne _,_J
OK I Cancel

Bl 1-4 B2 %S E] X A HE
jasmine, R B X jasmine. dsw CHRI AT,

ine’: 0 project(s]!

=] FileView |

B 1-5 T YE%5 (8] & K & 51K “FileView”

1.2.2 GIZImB

R TEZNE, EELPES A CHIE @5 H kMR T U, J-E ik
— P REFWEA., QIESENT.

O Compaq Visual Fortran 6.6 ) F & 0 Pk “File” >“New "€ # i 4 » T “ New”
XF G HE , YEBE“Projects” ¥ W , I 2 B N A #2 /5 28 8 “Fortran Console Application”, Rl #%
il & N R FF .

@k “Add to current workspace” L& . fE “Project name” LA HE Fl1“ Location” L4~
HE eh 43 0 0 AT B 22 PR BE AR . BEAR S At WY B A ) 4 A AT O D Y R 0 A R L A B AR
XEATESE P EETH example, W 7E X 4 % E: \jasmine # 4= B — 4~ 87 8 F S04 %
example, {NE 1-6 fIf 7~ ,

QMM AJE, B “OK” &M, AR/ EH T H LM, — B &K IAK“An empty
project” 26 AU, 4R J5 B 7 “Finish”# 4 , F 7€ 1 LA XJ 35 #E b 81 o5 “OK " $e #l , B )5 A 0 H 4
{4 example. dsp,



% 1% Compaq Visual Fortran 6. 6 £ T ZHE %, 7

Files Projects

| Other Ds I

=% Fortran Console Application Project name:
%| Fortran Dynamic Link Library chample

'wi Fortran Standard Graphics or QuickWin Application
€|Fortran Static Library 2
‘=] Fortran Windows Application Lnj?ﬁon.

I+ Makefile lE:\jasmIn:\example il
71 Utility Project

€ Create new workspace
@ Add to current workspace
I Depentdency of:

| 5

Platforms:

[:?wmaz
0K l Cancel
& 1-6  Fram H X EHE

1.2.3 GIBERERFXHE

FEIILH v S B0 IR AR I S L AR S AR T A A A Y UR SO R B e . R A
L 31

D# Compaq Visual Fortran 6. 6 B F & M HEH “File” >“New” 3 B 4, T “New”
o T AE L PEEL Files” 2B T0 . BB SC{4 25 %) 1 “Fortran Free Format Source File”, B B i #& (.

@ikrh“Add to project” & B HE , P FET H 4 , 7E“ File” LA HE Al “ Location” SCASHE H 43+ 5]
iy AR P S48 M A . AR S AL T S A 4% B AT O B AR B O T O R A AL BR AR

Qe WUl A5 Bl OK™ 12 #1181 # 3 i U e SO, n P 1-7 BiR .

N T R

Files | Projects | Worksp | other D |

Binary File ¥ Add to project:
Bitmap File
& Cursor File |example =l

Icon File File

Resource Script ]programl

Resource Template I
[ Text File Logation:

IE:Uasmlne\examplc :]

oK l Cancel
7 GIRIRRT SIS HE

=
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X, 7E TAEZS A 6 0 A 4T — 25 IR AR P SO &1 1 ZE SRS 8 1 b g R Y . (BOE
FE3 H B AR F X programl. 190, B S 7E“File View” 0 F H {9 3 H jasmine
T, 8 H R AR T X programl. {90, W& 1-8 fi/x . [E B, 78 X4 3 E:\jasmine\example
oA W% S, DA B R AT IR IR AR P, W FT X A4~ SO R AT,

‘. jasmine — Compaq Visual Fortran — [E:\...\example\programl.f90]

|Brite gait View Insert Broject Build Taols Mindor Hely =]
|2 @@ | e o- - mEE @ Clw

ICEEEL IS s
— .« [ INTEGER X,V tEFY
@ Workspace ‘jasmine’: 1 proj A READ =,X,¥ ¢ A iR

= @gasmple ﬁIFe"s ﬁ: ::;
= ource Files i PRINT x,X,v 35 HEE
Sprogrami @] || o .
(2} Header Files

=

el »

x =]
Jtexam:nle.exe - 8 error(s), 8 warning(s)
=
"
|| TSI3\ Bui1a ( Doz ) Find in Files 1 N4 4

| Ln6, C

B 1-8  #E X F programl. 90

ol4 |REC [coL [ova[READ

1.2.4 HwmEFEBEBEFXH

X U AR Y AT 4R %R AR R B AR R F S0 oobj SO MEZEEME AT, HwiFd R aEk
R IAHERR R A R

Xt H e A IR R SO AT g, A 4 R RAE DT

D& “Build”—=*Compile examplel. 190”3 By,

@ TAEZ 8l 8 O 4 % ¥ examplel. {90 CH#F, 47 i Blow 30 PR BE S 80, W op 3 4%
“Compile examplel. 90" H a4 .

@ # i “Build” T B A2 1 9 “ Compile” (Hi i) #&4H .

@ Ctrl+F7 &8,

fERFSEP, B TIEEEE. RS RE EREE 0P BRGFSERELS. WAL
BRI B RS B “programl. obj-0 error(s),0 warning(s)”, BN B RERER. Fi
i, #HHIFA“READ * X, Y'8IRE W "REAF » , X, Y”, W B/R ARG R .

Compiling Fortran. . .

E:\jasmine\example\programl. {90

E:\jasmine\example\programl. f90(2) : Error: Syntax error, found ' * " when expecting one of: (; %. = =>
REAF = ,X,Y ! % ASdE

Error executing df. exe.

example. exe-1 error(s), 0 warning(s)



% 1 E Compaq Visual Fortran 6. 6 £ X HKIE % 9

PR RE B A& SO 58 1 ATASE 2 7 B EFE SR MR 7 58 3 1T9R il MR
fER IR T4 ﬁ(%‘ﬁ 211, ’%Rlﬂiﬁﬁlﬁ%’f"*m FERE RS IR REAF B R HF
IR FRFRL A7 7 L =T =T SRR + 7, B AR AR IR 5 4 T RIS 5 T4
th J‘Elﬂn%’f&&ﬂ’h%’j-“i%%“ B IR AL E 58 6 1798 BT df BF i AR IR 38 7
T4 Hh i B A R R I EL

TR BB R R R R B AR B AT B [6) (B DR A5 B ek 19 7 0 A 8l 1, 1 P AR B 7R
(A DR R AT AR i R 7 8 AR O BB BORIE R R

i 13 0B IR B RS L T SO g N A 2 SO ¢ Debug, 7E Debug A4 B B A5 SCAHF
programl. obj FIAT X4 P15 B M B 2 (4 example. pdb, 7E 3 H SCF 3 4 A4 BUZ I B A %
VR T2 ¥ G 18 (045 B S example. plg.

1.2.5 HMEBTHITXH

R 0 B AR R SO A B LR RAT Y L 6 2B B A BT AT R S (L exe SUIH)
AR RS NWBRFAITEI LTI RBETESR. MARFWEORES, K2 BirE
Fe XS R G AR SC AR S ] TE L F R P A BUE CREF i — R, A e B ]
PATERFAN, SR P UEA A R MHER — 2 E ke iR,

Xt HARER P ST A 4 R E .

D EFE“Build”—*“Build example. exe” 3 H45 4 .

OFE TAEZS M % 12T H example, 47 i BUPR 58 ) EREESE R, 3 $£“Build” 3R B ap 2

@it Build” T HA% P 9" Build” ) % 4

@& F7 Dihet.

MR R R HEAT A GBI A A . WA IS ERINE D B4 RER, R
TG 15 B R ) i 7R “examplel. exe-0 error(s),0 warning(s)”, H M BR4ERERFERE. FE
I AU T4 13605 B R .

TE A AR HE 25 RS T H S e B F S0 e Debug A AR B AT U7 T 2 P XA example. exe Fl
#H 9 30 example. pdb ., [A] & 2 B SCH e N 1945 B304 example. plg.

1.2.6 E1TERF

He T AT R SO R R B AT T BT R IF U A BRI BT SR, BT R P daEk
£ Kk BLAHERR — iﬁn{f%mo

BRI EE A 3Tk,

D EFE* Build”—=*“Execute example. exe” 3B iyd

@ #ii“Build” T B #1 f“ Execute Program”( Jé T4,

@ Ctrl+F5 H A4,

T2 o QSR A e AR S AT R IR A O L 7R D R R AR . B 1T
R LT R AR B O BR BT RIRGE R . Bl AT ER & B /R 0,
W BLE AT AS R . P BOE A R R R IR W EFE T, ERE TIER.
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A EARTE47—4 FORTRAN 95 ¥ (i 72 , W SR 25817 T — 0% . ol LU H #41
H T AE=S 8], i 78 B 8 7 09 TAE 2 [a] dr g 7 B A 351 B S f8 FF SCHFBP AT, — > AR 2 6] 7] DL
FEANTHE.

] LA F— 350 © i 2 R R IR AR P SO, o ik 2 AR s g i R Y X R LT
PR o PR s A g, e B R BESE B ) “Insert File into Project”3g 8idn 4, EIZ R R T X
4G A BN B X B E TAE S 8] % 1A Source Files SCF3 v, 8 88 A IR AR 17 SO & 1> M
5t B e i B .

FE AR PR BRESIAMALTHARS MRS ATEARAAHTFTELZ, X
AE@e 7 & BRATABEAZRA ¢,

EAE R AR R AT B IR R 7 S A B3 H b, 8] UAE TAEZS (B & 0 A7 i Source
Files SC4 e , R J5 76 5 H 5 PR B SE B 1% 8 “ Add Files to Folder” 32 #idiy 4, tH Bl “Insert Files
into Project” % i #E , 46 £ 2 it A B0 H v i U F2 FF SO, BV AT U R 7 SCF i A B3 E

Xt F A JLAN IR ST H  TAEZS [ 8 1SR I0 B B4 & 09 A I8 30 B B I SO L i
HL AT ARt [ o i R R I S 44 AT TR IR e SO

IR NI H PR E SO fE TAEZS B N k£ “FileView” @® IR, HEFRZEMNTE $ 5
FE B34 1% Delete 82RP AT,

1.3 BHAEIRS

145 FORTRAN 95 i F#2 F# it 7] LI | Compaq Visual Fortran 6. 6 # B &4t , Bk Al
LA YT B AIL S B S, AT DA SCAS 7 11 A DG gt ) fifi B T SCBUBREE B .

WEFEE, MU ERMB RS, %8 “Tools” >"“Options” 3 Ay 4, BEFF “Help System”
IR R EHETEEHRITRE.

1.3.1 {ERBYLE B

W Y I ML A B A5 B . 2 “ Help” — “ Contents” 3¢ B fiy 4, 8 “ Search” 3¢ . iy &, 5
“Index”ZE M4 . BEMLEE I O A2 30 WoR T HRHLHS B N A M TE 250 2, A7 il 7R 1 Ir ik 2
A IE X2 I 1-9 B,

W I 45 4 22 1 B J7 12 0 Windows BE I8 B 88 TR AH [R] .

FATH— A, i B4 S B4 S L kB4 4 A ) R AL
9. BEATH G & wn A EEE R

B — A, i 5 4 AT A [ElEon i 45 45 B B R T Bk R B & i A O T ke
HOEH . By & i rE1As .

BHE D EBANE DG Z 3842 R BT AR % RN A SR R EE O
B, EEOME LA S T B, b X sede il , nT LA RS Sh B AR G Y £,

FECA G BT 1, 36 AT LA F1 Zh A SR AR A8 — > SR B 1) sl oR B A9 1 F SCUR B B . 6l



% 1&E Compaq Visual Fortran 6. 6 £ FF &K ZC}\ 11

E? Compaq Visual Fortran

THE RED SFQ BRE BHO

v & o N & & O
MR ER ¢ F—# 5¢  me Bl BE EN B A0 i@
EHFR D) - &
[em%2) =
e R—— .
BRO | mlw | #xe | #a] Compaq
= () Compag Visual Fortran 6.6 H
O ko | Visual
= L Visual Fortran !
il Fortran |

2] Programmer’s Guide
# Language Reference |
i+ Eror Messages
s @ Compag Aray Visualizer
+ @ Developer Studio 58
i+ @ Platform SDK
# @ SDK Documentation

Version 6.6

Home Page

Compagq Visual Fortran (also referred to as Visual Fortran; previously
called DIGITAL Visual Fortran) includes the following online
documentation:

e Programmer’'s Guide

» Language Reference b

B 1-9 EXPLEEBE O

n, FERR T b B A e B MAX (B AR 75 78 3% ok 801 K S 28 20 AR [] 45 2R 9 26 B4, n] DLAE g A
MAX JFEXAR# E] MAX Fref 8 4% F1 st W B R4 8o D0fF 8" 8T MAX 19
5340 AT AR O g RS DR (R SR F1 D RERRIRAS BT SCURRE B

1.3.2 REFHER

A LAfE Compaq Visual Fortran 6. 6 #§ B & 48t e S B AQ RERALAE Bh iy £, WA R
— AN, T LAEPE“ Help”—>“Search” 3¢ 8 i &, B Search %7 11, 75 2 1 AE Hh iy A KR 2R G
i), B B M R L G BT T %) 0 R HE T SR BB AR OC E R, RS RAE P PR A
R, B s L B L P R R A,

T O AR AL B SO IR EL TR INE

e “Help”“Index” 3 B2 AER B & O i3 Index B H . 754 #HE 5l A BT /5 2
V) 610 1) B 0 L ELREAE T T Y 51 R AE b XU TR A 3

1.4 ¥ B iAid

PP —Fh G PR 75 30, 5 R W SR A L B R B B0 T — R
AR AR . TEXEEIE D, ) BUAEIR 2 HE SR L T DL RE DRE A 4R R BN A IE AR I 9 R
RXBRIF R A R B EAZOR,
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1.4.1 ERFRWAZE

R B R AT B T BRI . O TR B X SR IR, R E R - SR A R
RORGEHERROERMAE . TEAEILFE ORI, XS EdE FReE
Fefdi A

1. A A &2 %15 &

EHEETERT RERE LSRG A SIS G R, 7T LR E X (5 B R B B2 7
PP B DR O X R AT B

(D HwiFd B AR

FEgFHERTH RFREMNBERFHTEER, S ERFPRIEERRSS HEHRE
S FH P AT DAAR R 3 S A R AR B R A DT R P T A R D R AT AR B B, BT E AR AR
BREFF -SSR EFSERGEE EXMEN T, Wl g AT 4 E— 18R E R
BIwT, @, 588 b e B v E A S X it IR 5 A XN BIFITH S EIER
gt e, EXFERT ., RESK T HAVRIEDNE R, HRERMSREE K.

(2) % Head B b By iR

fEEZEIRPESRBFRCZEEBFRE TS REZEMBMHAXER. WREFPA
TV A R B RS R ] A O T AR E RS R R

(3B FTid B A AR

BRZEHIFEMERSBEPOAKCHRR TEF P — S8R B AR T — &
EIERETT T . ANERTFEITHEAHIR, T2,

FEIF AT B R R B Rl DUE A P26 — R BT R 7 T AL R S 4 i R iR R
B X R EER R £ 102 5 B0 B A s XS SO AE AR O 5 — SRR R B N B 1T
ff 28 G5 AN 1E 3 s 45 R AN IE B, AN AN BB IE 6 45 0, LA B B0 A fo] i 11 45 2R sl Hh 45 2R 5 L
A — %,

2. BN RKIE G

B T A R G4 s B R AT 4 BT AR B4R 22 A, iR B R R — 2 T vk W R i
JETERRIF i A — 2 i ),

AR aE A LR LR,

(D EREA &

FE MR oG — RS AR & B R T BT 45 2OR S AR B — R
(B, MR 40 45 R 25 A B AR, T LA 0 R O 1 B ) K BB AR

()BTRS

AP IC S EEAG h R — AR BT B AR F R ARG —IK,
fEHEC— W SRR AS AT L AR T B B A 1T L S AR O v A FEAE B e, O A O R B AR
P e .
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()l AFTEIIE )

FTEQ 8 4] i foc i FH B — PR 4], ATENE A A RRRAEE HE,. BB F 2 A NG R
FTENERIA LT LR A .

® [F] R ATED . [] 75 4T BN A9 45 SR R FT ED B M) i B S B0l Al (B A B Z 5 . FRF
V8 FH B A A . AT LARS Bh A A R E B i A B SR TR B ERIER.

® B ERFTED 8 BRTT R A SRR BAT 00 BRARME BT B A AT ENE A) X AT BB ]
R E R AR S A E A RS RSN — R SRR —RiIEA LV ERE
VEPR G5 4 J T A 5 — 2R ) o SR Z R B A SO I AR — SR TR .

® Sl S ATED A A AT ENBL Rk B — 2] BE SR B AT ENiE A, LAEAT ENAH AR B (L.

3. A H A

5ek 1l B AR J2 48 A R R ) L 28 (R R A Nl o BT T RE B R T B R, R L HERR B
WRBRIT S B/ BRI,

4. 5B A T A
LA ARG REN AKX TR HTRF AP BEERETT.

1.4.2 BAAXITENER

Compaq Visual Fortran 6. 6 £ & FH 4L T &R T B Debugger . f#f F & 7l LA il —
AP B RAT o SRR 7 AT AR A — AR PP B AR A AR SR RS

L. iR AT 09 0 & TAF

FEVAR T Z 00, B e T EHRMBIFMERBE R, RIFMEENHRGEERER D HE
R R AR S B P & T A RACS LB B8 A BT AE B ST AT 5 B4 1% 0 1] B2 4 0 5 7 42
HIRERRA N THRR SRR, FAEREERIFASHEAGMRE - FETMHEE, RH
MEEERGEEPRATS. EROE D, TR SITEHEIREE.

M E O GFEIREN R, HAENMERFTORE BR., AT ERRIFHR,
F R AR E O AMEXHED . RARESEBERER, TUBIEARAIXRE
B L. ¥ F1 RS H XN BIE R .. 7EHBR iR m iR at, I 2 Al 1 )5 247, B b 4 i
THHAMMBEARETREHAIHE - TERIER.

— B AR A, Compaq Visual Fortran 6. 6 £ & M & “Build” 3 .15 48 i, “ Debug” 3¢
B, R AT FENEF AR,

2. 542 X B BT A

FIr 8 B 53 (Breakpoint) . i R B FEE T A B P EERE AL E . KA, ] LIA R0
BRI RET. BB B iR B W AR FAT, £ Build” T B £ o 8 35 i
AR B #%# (Insert/Remove Breakpoint) (% F9 Jyae s, Bl Al 7R X B A AL B0 & — T s B
R E AR — NI a4, B T BTN I



